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PLACEMENT OF THE SPRIMAGER®II IN YOUR LABORATORY 

 

 

 

Your SPRimager®II has a footprint small enough to place on your lab bench, and uses 

standard electrical power.  For optimum performance, the position where the instrument is 

placed should be: 

 Horizontal and vibration-free 

 Away from direct sunlight 

 Clear of any sources of hot or cold air or other temperature disturbances 

 Clear of areas where the instrument may be exposed to water or other liquid spills 

 



 3 

 

 

 

Contents 
 

 

ABOUT THIS MANUAL ..................................................................................................................................... 5 

HOW TO USE YOUR SPRIMAGER®II ........................................................................................................... 5 

1.  TURN ON THE SPRIMAGER®II FOR AT LEAST AN HOUR TO STABLIZE THE INSTRUMENT ................................. 6 
2.  SET THE TEMPERATURE ................................................................................................................................... 6 
3.  CLAMP THE ARRAY IN THE PRISM-FLOW CELL FIXTURE ................................................................................... 7 

Orientation of the Array ................................................................................................................................. 9 
4. MOUNT THE PRISM-FLOW CELL ASSEMBLY ON THE SPRIMAGER®II ........................................................... 9 
5. CONNECT THE PUMP TUBING AND FILL THE FLOW CELL WITH BUFFER ...................................................... 10 
6.   OPTIMIZE THE ANGLE OF LIGHT INCIDENT ON THE PRISM ............................................................................. 10 
7.  COLLECT DATA ............................................................................................................................................. 12 
8.  ANALYZE THE DATA. .................................................................................................................................... 14 

Obtaining difference images ......................................................................................................................... 14 
Analyzing difference images ......................................................................................................................... 15 
Using ROIs rather than line plots for image analysis .................................................................................. 16 

9.  DISASSEMBLE THE PRISM-FLOW CELL ASSEMBLY AND RINSE THE COMPONENTS .......................................... 16 

TROUBLESHOOTING...................................................................................................................................... 17 

BUBBLES OR LEAKS IN THE FLOW CELL ............................................................................................................ 17 
MAKING SURE THE SPRCHIP™ IS ORIENTED CORRECTLY .................................................................................. 17 
TEMPERATURE REGULATION ............................................................................................................................. 18 
NON-UNIFORM IMAGE BACKGROUND ................................................................................................................. 18 
LOW SPR SIGNAL ................................................................................................................................................ 18 

ADDITIONAL EXPERIMENTAL DESIGNS ................................................................................................. 20 

MEASURING INTERACTION AFFINITIES .............................................................................................................. 20 
MONITORING CHANGES OVER A TIME COURSE—A SIMPLE 1% ETHANOL TEST ................................................. 20 
SEQUENTIAL BINDING EXPERIMENTS ................................................................................................................. 25 
OPTIONAL CONVERSION OF DATA TO REFLECTIVITY CHANGES ........................................................................ 26 
FEATURES OF THE NINE V++ MACRO FUNCTIONS PROVIDED BY GWC .............................................................. 27 

Line Profile Macro ......................................................................................................................................................27 
Acquire Average Image Macro ...................................................................................................................................27 
Convert to 8-bit Image Macro ....................................................................................................................................27 
TimeSeries Macro .......................................................................................................................................................28 
FastTimeSeries Macro ................................................................................................................................................28 
Playback Macro ..........................................................................................................................................................29 
Average Macro ...........................................................................................................................................................29 
Standard Deviation Macro ..........................................................................................................................................29 
Version Number Macro ..............................................................................................................................................29 

HINTS FOR USING THE V++ SOFTWARE FOR DATA COLLECTION AND ANALYSIS ............................................. 29 
Toolbar Buttons Versus Menus ..................................................................................................................................29 
Selecting Specific Regions of the Chip for Analysis:  ―Select ROI‖ ..........................................................................30 
Placing and Removing Flags ......................................................................................................................................30 
Assessing Image Quality:  Image Statistics ................................................................................................................30 
Displaying Image Intensity with Row and Column Plots ...........................................................................................30 



 4 

Manipulating Images using the Math functions:  Image Subtraction ..........................................................................31 
 

 

 

 

 

Evaluating Multiple Images Using the Sequence Functions .......................................................................................31 
Converting Image Types .............................................................................................................................................32 

To convert 32-bit SPR images to 8-bit images ............................................................................................. 32 

GUIDELINES FOR MAKING PROBE ARRAYS ON GOLD CHIPS ......................................................... 33 

Strategy for probe attachment ...................................................................................................................... 33 
Additional Guidelines for Making Arrays .................................................................................................... 34 

Probe Size ...................................................................................................................................................................34 
Guidelines for DNA Probe arrays ................................................................................................................ 35 
Guidelines for Peptide and Protein Probe Arrays........................................................................................ 35 

UNDERSTANDING SURFACE PLASMON RESONANCE ......................................................................... 36 

SURFACE PLASMON RESONANCE DETECTION ................................................................................................... 36 
How SPR Imaging differs from Traditional SPR methods............................................................................ 36 
GWC’s SPRimager®II. ................................................................................................................................ 37 

REFERENCES .................................................................................................................................................... 38 

APPENDIX I  COMPONENTS LIST FOR YOUR SPRIMAGER®II SYSTEM ........................................ 39 

COMPUTER COMPONENTS .................................................................................................................................. 39 

APPENDIX II:  CHANGING THE LAMP ...................................................................................................... 40 

APPENDIX III:  HOW TO SETUP THE SPRIMAGER®II .......................................................................... 42 

SETTING UP THE COMPUTER .............................................................................................................................. 42 
Ensuring your Windows computer has the appropriate operating system and application software .......... 42 
Install the XCAP Software ............................................................................................................................ 43 
Install the PIXCI video capture board.......................................................................................................... 43 
Install the Digital Optics V++ image analysis software .............................................................................. 46 
Install and test the V++ driver software for the video capture board .......................................................... 46 
Install the GWC Macro module for V++ ..................................................................................................... 48 

 

Copyright © GWC Technologies Inc., 2008 

All rights reserved 

 

 

 

GWC Catalog #SPR-1000-060;  $60 



 5 

About this manual 
 

In this manual, you will find: 

 

 Details on how to use the SPRimager®II system; 

 Suggestions on how to analyze the data obtained 

 Tips on troubleshooting instrument operation 

 Suggestions on alternative experimental designs 

 An introduction to the V++ image analysis software 

 Hints on using V++ efficiently 

 Guidelines for making arrays of molecular probes 

 Background information on Surface Plasmon Resonance Imaging 

 Selected references 

 An appendix detailing how to set up the computer for the SPRimager®II—this is usually done for 

you prior to installation of the system. 

 

For advice on experimental approaches for your particular research, or if you would like to receive 

specific experimental protocols from GWC’s protocol series, please contact your GWC Technologies 

representative. 

 

How to use your SPRimager®II 
Using the SPRimager®II to analyze probe arrays can be organized into nine steps: 

1. Turn on the SPRimager®II for at least an hour to stablize the instrument 

2. Set the temperature 

3. Clamp the array in the prism-flow cell fixture 

4. Mount the prism-flow cell on the SPRimager®II 

5. Connect the pump tubing and fill the flow cell with buffer 

6. Adjust the angle of light incident on the prism to the optimum position 

7. Collect data 

8. Analyze the data. 

9. Disassemble the prism-flow cell assembly and rinse the components 

Details for each of these steps are presented below.   
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1.  TURN ON THE SPRIMAGER®II FOR AT LEAST AN HOUR TO STABLIZE THE 

INSTRUMENT 

A stable light source is critical for reliable SPR measurements.  Therefore the SPRimager®II light 

source must be turned on for at least an hour prior to use.  When the SPRimager®II is in regular use, 

we recommend leaving the light on permanently. 

To turn the instrument on, press the on/off switch located on the back left-hand side of the instrument.  

If the pump is on, turn it off for now by depressing the green pump switch. 

2.  SET THE TEMPERATURE 

1. To run your experiment at a temperature higher than ambient, use the temperature control as 

follows: 

 Disconnect the white connector of the temperature sensor cable (see below). 

 Screw the temperature sensor into the hole in the 

upper left corner of the assembly next to the flow cell. 

 Reconnect the white connector of the temperature 

sensor cable. 

For experiments at ambient temperature, there is no need 

to attach the temperature sensor, but the temperature 

controller should then be set to a temperature below 

ambient. 

2. To set the flow cell temperature (up to 60°), hold down 

the leftmost ―star‖ button on the temperature control 

panel (see image at right) then push the up or down 

button to change the set temperature.  The digital display 

will show the set temperature as long as the leftmost 

button is depressed.  When the desired temperature 

setting is reached, release the leftmost button;  the digital 

display will now show the current temperature. 

Allow the instrument to equilibrate for at least 30 min 

each time you adjust the temperature. 

For experiments at room temperature, adjust the 

temperature set point several degrees below ambient to 

make sure the heater does not turn on. 

The SPRimager®II control panel 
(above) showing the pump rate 
control (left arrow) and pump On/Off 
switch (right arrow). 

Temperature 
sensor 

Temperature sensor cable 
connector (above) and location 
of the temperature sensor 
connected to the top corner of 
the prism assembly (right)  
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For all experiments, be sure to equilibrate the analyte and wash solutions you want to use to 

the same temperature as the flow cell.  SPR detection is very sensitive to fluctuations in 

temperature, so constant temperature is helpful for maximum sensitivity.  Although control 

regions on the array can be used to correct for variations in temperature, large temperature 

changes during an experiment could move the sensing system out of its dynamic range. 

3.  CLAMP THE ARRAY IN THE PRISM-FLOW CELL FIXTURE 

The different parts of the prism-flow cell fixture are listed on page 39.  You will need to handle the 

chip, the prism and the flow cell during this step.  The following measures will help to avoid problems: 

 Always wear gloves to avoid smudging the optical surfaces and contaminating parts with 

nucleases and proteases. 

 Handle the prism only from the two non-polished sides.  When setting the prism down, lay it on 

one of its two non-polished surfaces on a clean lint-free surface such as lens paper. 

 Hold the chip with clean tweezers on the glass margins.  Avoid touching the gold surfaces. 

 Clean the chip and the prism as described, both after you disassemble and before you assemble 

the sample cell. 

 When tightening screws do so very carefully.  If you slip with the screwdriver you could scratch 

optical or other instrument surfaces. 

 

1. Clean the three optical sides of the prism one at a time using ethanol and lens paper as follows: 

a. Place one drop of ethanol at one corner of a sheet of lens paper 

b. Touch the ethanol-wetted corner of the lens paper lightly to the prism surface, then drag the 

paper over the face of the prism, making sure the whole face is rinsed and then completely 

dried.  Repeat for each face of the prism.  There should be no visible marks of any kind on the 

faces of the prism when you are done. 

c. When all three optical faces are cleaned, lay the prism down on one of its two non-polished 

surfaces. 

2. Place the cell holder on clean lens paper with the thumbscrew upppermost.  Unscrew the 

thumbscrew almost all the way up, then, using tweezers, position the chip gold-side-down in the 

cell holder, guided by the four corners cut in the holder. 

For SpotReady™ chips, make sure that the orientation spot is in the upper right corner to 

ensure the gold surface faces down. 

If you lose track of the orientation of the uniformly coated gold SPRchip™, you can identify 

the gold plated side by viewing the edge of the chip at a slight angle, the side with the gold 

coating is then clearly visible.  Additional hints can be found on page 17. 

3. Inspect the glass surface (which is now uppermost) of your array for dust or dirt.  If this glass 

surface is not perfectly clean, gently wipe off dust or dirt with a methanol-soaked Q-tip® or 

similar device. 

If you need to clean a chip that has probes attached to it, do not allow the probe side of the 

chip to come into contact with ethanol. 




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4. Without touching the chip surface, put one drop of index 

matching fluid (Cargille, RI=1.720) on the chip and then 

gently lower the prism on top of the chip at a slight angle to 

avoid bubble formation. 

The refractive index of the fluid matches that of the glass of 

the prism and the chips.  Its use minimizes light scattering at 

the interface between the chip and the prism. 

Put the drop of index  matching fluid near the center of the 

chip. To avoid bubble formation, position one edge of the 

prism on the metal mount so that the apex of the prism will 

be directly over the center of the chip when the prism is 

resting on the chip.  Then lower the prism until it rests on the 

chip surface. 

Another way to avoid bubbles is to lower the prism directly on 

top of the chip making sure that the face of the prism first 

touches the drop of index fluid before you gently let it rest on 

the chip.  The index matching fluid should spread out evenly 

(you can see the surface of chip through the prism).  

To remove any bubbles in the matching fluid between the 

prism and the chip, disassemble the chip from the prism, and 

repeat Steps 1-3 above.  To separate the chip from the prism, lift the prism—the chip will 

remain attached to it.  Using tweezers, gently nudge the chip off the edge of the prism until you 

can grab it with your tweezers and pull it off. 

5. Place the prism wedge on to the apex of the prism.  If your prism is centered, the screw will be 

directly over the recess in the wedge. If the prism is not completely centered, gently nudge it with 

your tweezers until it is centered.  Hand-tighten the thumbscrew so that chip and prism are held 

firmly in place. 

6. Ensure that the flow cell is clean and dry.  If you are not sure if the cell is dry, force a stream of 

nitrogen or other dry non-hazardous gas through the ports and over the O-ring groove. 

7. Position the O-ring in the O-ring groove of the flow cell. 

Be sure to keep the flow cell and O-ring perfectly clean and dry.  Even a small amount of dust 

or moisture in the openings or on the surface of the flow cell can result in bubble formation 

when solution is initially flowed into the cell. 

8. Turn the assembled prism over and lower the 

flow cell on to the chip with the four screw 

holes aligned with the screw holes in the 

prism mount.  It is preferable to orient the 

flow cell so that the inlet and outlet ports are 

arranged vertically when positioned on the 

SPRimager®II.  Insert the screws and tighten 

them using the supplied Allen wrench.  To 

ensure even, firm pressure across the surface, 

tighten them gradually in diagonally opposite 

pairs.  Avoid over-tightening.  When done 

tightening, you can see the O-ring 

compressed against the gold side of the chip 

when you look through the prism. 

The prism-flow cell fixture, with an 

SPRchip™ in place, gold surface 

down, and a drop of matching fluid 

added to the upper glass face of the 

chip. 

A completely assembled sample cell—the cell holder, 

with the chip and prism clamped into place, flow cell 

attached, and input / output ports screwed in. 
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9. Ensure the two ports are completely dry.  Screw the input port into the lower opening and the 

output port into the higher opening.  Hand-tighten.  The assembled sample cell is now ready to be 

placed into  the SPRimager®II. 

 

Orientation of the Array 

When the array is mounted on the SPRimager®II, the path of light reflection and image collection 

causes reorientation of the probe regions.  The sketches below provide a suggestion for how to track 

the probes on your array.  The left-hand sketch of the array indicates one way to number the 16 probe 

regions on a SpotReady™16 chip.  Spot ―O‖ is the orientation spot, and is oriented ―top left‖ here.  

The center sketch shows the same chip placed gold-side down on the cell holder, with the orientation 

spot now ―top right‖.  The sketch on the right shows the orientation of the probe regions on the 

corresponding image viewed on the computer screen. 

 

 

 

 

 

4. MOUNT THE PRISM-FLOW CELL 

ASSEMBLY ON THE SPRIMAGER®II 

Lower the assembled sample cell on to the 

rotating stage so that the two screws of the 

holder fit in place and the holder base covers 

the copper strip.  To ensure the correct 

orientation, recall that the gold surface of the 

chip must be positioned to reflect the light 

from the source onto the CCD camera.  When 

the assembly is correctly oriented, the exposed 

prism surfaces face the polarizer and camera 

as shown at right.  Carefully screw the sample 

cell in place, making sure not to damage any 

components with the screwdriver. 

 

Light Source 

Camera 

Angle 

Adjuster 

1 2 3 4

13 14 15 16

9 10 11 12

5 6 7 8

O

1 5 9 13

4 8 12 16

3 7 11 15

2 6 10 14

O
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5. CONNECT THE PUMP TUBING AND FILL THE FLOW CELL WITH BUFFER 

 

1. Assemble the supplied peristaltic pump tubing 

into the peristaltic pump.  The two plastic 

collars on the tubing (arrows at right) should 

connect to the outside of the tubing slots in the 

pump housing. 

If the tubing has been used previously, be sure 

to rinse it well with water, then ensure it is dry 

by streaming Nitrogen or another dry, non-

hazardous gas through it before assembly. 

You may find it easier to insert the tubing into 

the pump housing if the pump is turning slowly. 

2. Connect tubing to the (lower) inlet port on the 

sample cell.  Connect a length of waste tubing 

to the outlet port on the flow cell. 

You may flow liquid in either direction through 

the flow cell, according to how you connect the 

tubing—i.e. you may “pull” liquid through or “push” liquid through per your preference.. 

3. Place the end of the input tubing in a reservoir of buffer. 

You will need at least 0.5mL to fill the tubing and flow cell with buffer or analyte. 

Be sure the buffer is the same solution in which analyte is dissolved, and that the buffer has 

had time to equilibrate to the temperature set for the experiment. 

4. Place the end of the output tubing in a waste container. 

5. Turn the pump on by depressing the green pump switch and set the speed to maximum by rotating 

the pump control knob beside the pump switch fully clockwise. (see image page 6)  Continue 

pumping until the buffer begins to exit from the outlet port, then turn the pump off. 

Observe the meniscus as the water fills the tubing and moves towards the cell.  You should see 

a solid column of liquid slowly moving along the tube.  When the input tubing, flow cell and 

output tubing are all full, water should flow out of the waste tubing only and there should be 

no leaks around the base of the flow cell. 

(The flow rate with the supplied 0.031” ID tubing is 50-920L/min.) 

 

6.   OPTIMIZE THE ANGLE OF LIGHT INCIDENT ON THE PRISM 

1. On the computer, launch V++ if it is not already running and click once on the ―L‖ Line Profile 

macro button.  This launches the GWC Line Profile program. 

The left-hand window of the line profile prgram shows a live image of the array in the flow cell.  

While there is no liquid in the flow cell, this image will be bright white. 

2. Once the flow cell is filled with water, turn off the pump. 

3. Using the mouse, Click-Drag-Release on the image of the array in the left-hand line profile 

window, to draw a straight line across a region of the array.  The exact length and region are not 

Peristaltic pump with tubing attached.  The two 
arrows point to the collars on the tubing, which 
attach just below the brackets on the pump 
housing. 
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important at this point.  If you are not satisfied with the position of the line, simply Click-Drag-

Release to draw it again: 

The line you draw on the image determines the line of points from which intensities are 

measured and displayed in the right-hand window.  These points are measured in real time, so 

they will change if you rotate the prism.  The example below shows the line drawn vertically 

through a column of gold spots on a SpotReady™16 chip.  Note that the reflectivity loss due to 

the SPR response is restricted to the gold spots—the surrounding glass area reflects the light.  

The inset, bottom left, shows the use of line profile with a plain gold SPRchip™.  Reflectivity is 

reduced  across the entire surface, because there is no bare glass on the plain gold chip. 

4. Referring to the scale on the y-axis of the right-hand Line Profile window, observe the pixel 

intensity values (0-255) indicated for the line you drew on the image.  Turn the angle adjustment 

screw (see image below  until the pixel value for regions of the gold spots reaches a minimum.  

Estimate this minimum pixel value (= MinPV) from the scale on the y-axis of the line profile 

window. 

5. Now turn the angle adjustment screw 

counter-clockwise until the pixel value 

reaches a maximum.  Estimate this 

maximum pixel value (=MaxPV).  Now 

use the angle adjustment screw to set the 

pixel value to approximately [(MaxPV – 

MinPV)/3) + MinPV].  Typically this 

works out to a pixel value of 70-100. 

The purpose of this step is to set the angle 

of the incident light at a suitable position 

for (i) sensitivity and linearity of the SPR 

curve;  and (ii) contrast between different 

surface features.  This position 

 

 

Line drawn through 4 spots 

Intensity along the line drawn through the 4 spots 

Same procedure with 
uniform gold SPRchip™ 

 

Angle adjust screw 

Polarizer adjuster 
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corresponds to one third of the difference between the minimum and maximum reflectivities.  

The SPR curve below, with reflectivity (y-axis) plotted as a function of angle of incident light 

(x-axis), would have an optimum starting reflectivity for SPRimager®II measurements at the 

position indicated by the arrow. 

Troubleshooting Tip:  If, after you set the minimum reflectivity in Step 4, you turn the angle 

adjustment knob clockwise instead of counter-clockwise to estimate the maximum reflectivity, 

the light intensity will still increase, but you will be working on the region of the SPR curve to 

the right of the reflectivity minimum.  While this region of the curve can still yield measurable 

reflectivity changes, the sensitivity is lower (curve is flatter) and the linearity is inferior to the 

region to the left of the reflectivity minimum.  Also, increases in thickness (binding of analyte) 

would yield negative instead of positive reflectivity changes. 

6. Once you have adjusted the prism angle to your satisfaction, click the Exit button on the Line 

Profile window to close the Line Profile program.  You are now ready to collect data. 

Do not adjust the angle of the prism at any point during the experiment.  If the angle is 

adjusted after you start collecting data, it will not be possible to relate data collected before 

the adjustment to data collected after adjustment.  You should also be sure the SPRimager®II 

is on a stable surface, and take care to avoid any vibrations. 

Troubleshooting Tip:  The video capture board in your computer can communicate with only 

one program at a time.  Since V++ and Line Profile are independent programs, you should not 

try to use any V++ features while Line Profile is running.  If you do, V++ may crash. 

 

7.  COLLECT DATA 

For this example, we use a simple experiment to show that specific binding of biotinylated analytes to 

a streptavidin surface may be detected by SPR imaging.  The figure below outlines the complete 

experiment, stepwise details of how to perform the experiment follow. 

The experiment analyzes just three images of the same SpotReady™25 chip‖ 


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A) Image A shows the array in buffer before the experiment.  This is typically referred to as the 

―Reference Image‖.  The array has streptavidin probes immobilized on the top, fourth and bottom 

rows, and the top row has been ―blocked‖ by spotting biotin on the surface.  The second and 

middle rows have polyethylene glycol (PEG) in place of streptavidin, as controls. 

B) Image B shows the array after it is exposed to biotinylated oligonucleotide, then washed.  This 

may be referred to as the ―Post-binding Image‖.  To the eye, images A and B are indistinguishable. 

C) Image C shows the result of subtracting, Image A, the reference image, from Image B to generate 

the ―Difference Image‖.  This difference image shows increased reflectivity wherever the analyte 

bound to the array.  In this case, biotinylated oligo bound specifically to the bottom two rows of 

streptavidin probes, but not to the streptavidin pre-blocked with biotin, nor to the PEG controls. 

For many purposes, a simple experiment such as this one is all you need.  In other cases, you may 

want to collect images after a variety of different treatments, for example if you want to show that, 

after a calcium-dependent binding event has occurred, it can be reversed in buffer containing EGTA.  

Alternatively you may want to estimate affinities of interactions or collect data over a time course.  

Additional advice for performing such experiments is provided later in the section titled ―Additional 

Experimental Designs‖ (p 20).  Steps for performing this simple experiment are as follows: 

1. With the array in buffer on the SPRimager®II, but before exposing to analyte, click the Acquire 

average image Macro button (as shown at left) in V++.  When prompted for the number of images 

to average, type in 30 then choose OK.  An image of the array appears on screen. 

2. Choose File Save… to save the image.  Give the file a name you will comprehend, such as 

―Buffer1.tif‖.  Be sure to save in the default format, which is 32-bit tif. 

3. Place the end of the input tubing in a reservoir of 0.5mL of analyte.  With the pump speed control 

fully clockwise, turn the pump on and pump analyte into the flow cell until the analyte reservoir is 

nearly empty.  To avoid introducing bubbles into the flow cell, do not let the reservoir empty 

completely. 

This volume of analyte is sufficient to replace the buffer in the flow cell completely with 

analyte solution.  However, if you are performing quantitative analysis and you believe the 

analyte is not in excess, you should flow additional volumes of analyte into the fllow cell until 

no additional binding is observed. 

4. Incubate the array in the analyte solution for the time period needed. 

=

SA+Bi

m-PEG

n-PEG

SA

SA

Probe Array Probe Array + BiotinT7

Difference Image:  

signal due to binding 

of BiotinT7 to 

Streptavidin

A B

AB -

Reference Image Post-binding Image 

 

Difference 

Image 
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Higher affinity interactions require shorter incubation times than do lower affinity interactions.  

If unsure, you can take images at multiple time points rather than a single time point until no 

further binding is observed. 

5. Click the Acquire average image Macro button (as shown at left) in V++.  When prompted for the 

number of images to average, type in 30 then choose OK.  Another image of the array appears on 

screen. 

6. Choose File Save… to save the image.  Give the file a name you will comprehend, such as 

―Analyte1.tif‖.  Be sure to save in the default format, which is 32-bit tif. 

This second image may be all you need to complete the data collection, provided that the 

refractive index of your analyte solution is close to that of the buffer solution.  In this case, 

slight changes in refractive index can be corrected by adjusting for any changes in control 

probe regions on the array. 

If the refractive index of the analyte and buffer solutions differ significantly, it may be obvious 

on the image(s) of the array that you collect during exposure to analyte—visually obvious 

changes in reflectivity will be seen for control probe regions that are not expected to bind 

analyte.  In such cases, you will need to collect another image after washing with buffer, to 

bring the refractive index back to that used to collect the reference image. 

If you are unsure as to whether equilibrium binding has been reached, you can continue to 

collect images in analyte and analyze difference images until you observe no further change in 

reflectivity. 

6. To wash away analyte and replace with buffer, place the end of the input tubing in a reservoir of at 

least 0.5mL of buffer.  With the pump speed control fully clockwise, turn the pump on and pump 

buffer through the flow cell until the buffer reservoir is nearly empty. 

7. Click the Acquire average image Macro button (as shown at left) in V++.  When prompted for the 

number of images to average, type in 30 then choose OK.  Another image of the array appears on 

screen. 

7. Choose File Save… to save the image.  Give the file a name you will comprehend, such as 

―Wash1.tif‖.  Be sure to save in the default format, which is 32-bit tif. 

When you wash the array, dissociation of analyte from probes will begin, and will be faster for 

lower affinity interactions.  Therefore, if it is necessary to wash the array, try to be as fast as 

possible in collecting the post-wash image. 

If you want to convert the raw SPR response data to absolute reflectivity values, you will need 

to collect an image of the chip taken with s-polarized light to normalize for the p-polarized 

light used to elicit the SPR response.  You must collect the s-polarized image before moving 

the sample or adjusting the angle.  For instructions, see page 25. 

8.  ANALYZE THE DATA. 

Obtaining difference images 

1. Decide which image you want to use as the ―Post-binding image‖. 

The preferred choice is an image collected after incubation of analyte while the analyte is still 

present.  If this is not practicable due to substantial refractive index differences between buffer 

and analyate solution, choose the image collected after washing the array in buffer. 


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2. In V++, choose Math > Arithmetic to 

launch the image arithmetic menu. 

3. In the uppermost box of the Images section, select 

your Post-binding image in the pull-down list box. 

The pull-down list boxes show all open images.  If 

the image you want is not listed, open it now using 

the File > Open command, then return to the 

image arithmentic menu and choose it in the list 

box. 

4. In the next box in the Images section, choose your Reference image. 

5. In the bottom list box, type the name for the difference image you want to create. 

6. In the Operation section to the right of the Arithmetic menu, click the Subtract 

radio button. 

7. Click OK to create the difference image. 

The image that now appears on screen is the result of this arithmetic operation.  Areas 

where analyte bound to probe will show increased reflectivity.  However, small but 

significant reflectivity changes that can be readily quantified may not be visible to the 

eye.  If you cannot see any differences, you may enhance the brightness and contrast of 

the image using the V++ Intensity > Enhance command.   This launches the image 

enhancement dialog (see right);  use the slider controls to increase contrast and adjust 

brightness to highlight any small differences on your difference image. 

Note that the image enhancement controls affect only how the image is displayed.  The 

numerical data that specify the image are unaffected, so any quantitative functions you 

apply to the image are unaffected by enhancing its contrast. 

Analyzing difference images 

There are many ways you may quantify the image, and you may do so in V++ or in other 

popular image processing programs such as Image J from the National Institutes of health.  

Preferred applications are those that handle 32-bit tif images.  However, if your preferred 

application cannot import these, you may convert the image to 8-bit or 16-bit format using the 

V++ Tools > Convert Type menu.  The File > Save As command gives you 

several options for alternative formats. 

Following is one fast, easy way to quantify the difference image.  Superior methods are 

presented later: 

8. Click on the V++ Flag button on the toolbar (see left) 

to activate the flag placement function. 

9. Click at two or more points on the image spanning a 

region you want to quantify. 

10. Choose Intensity > Line Profile.  A graph 

showing image intensity in the area of the histogram is 

now displayed (see example at right). 

This line plot shows the pixel intensity along the 

straight line (shown in blue on the image for clarity) 

connecting the flags you place on the image. 

The result for this line shows an increase in intensity 

for the two center probes, where analyte molecules 
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bound, with negligible change  for the flanking probes, where analyte did not bind.  This shows 

that analyte bound specifically only to a subset of the probes. 

To extract numerical data from the plot, right-click on it and choose Copy.  This copies the  x- 

and y-values for the plot to the clipboard.  You may then paste the data into a spreadsheet or 

text document for further analysis. 

 

Using ROIs rather than line plots for image analysis 

 Instead of using line plots, you may instead draw one or more 

rectangular ROIs on the image and obtain histogram row or 

column plots to quantify the signals.  To draw ROIs, click on 

the ROI button on the tool bar and Click-Drag to draw an ROI 

over the region you want to quantify.  Then choose Instensity > 

Row and Column Plots to access the histrogram menu, from 

which you may choose from row vs column plots, ROI input, 

and operation you want to plot—usually this will be the mean.  

The benefit of histograms over line plots is that multiple pixels 

are averaged for each point on the row or column axis, 

potentially improving the signal-to-noise ratio. 

 For maximum performance, you may want to specify a region of interest on each probe spot, and 

collect data for each ROI independently.  This ensures that only data within the probe regions is 

included in the average pixel values, and adds flexibility for correcting experimental data points for 

control ROIs on the same array.  An example of how to do this is provided in the section below on 

Additional Experimental Designs (p 20). 

 

9.  DISASSEMBLE THE PRISM-FLOW CELL ASSEMBLY AND RINSE THE COMPONENTS 

Before removing the prism-flow cell assembly from the instrument, be sure you have collected all the 

data you need. 

1. If you used the temperature control, unscrew and remove the temperature sensor.  This step 

requires you first disconnect the sensor cord at the white connector. 

2. Pump distilled water through the flow cell to remove all residues of the analyte solution from the 

cell and tubing.  Then remove the open end of the input tubing from its reservoir and disconnect 

the input tubing from the input port.  Then continue pumping to empty the input tubing.  When the 

tubing is empty, turn off the pump. 

3. Detach the tubing from the outlet port.  For both the input and output tubing, flow through a 

stream of nitrogen or other nonhazardous dry gas to dry them thoroughly.  Store in a clean, dry, 

lint-free location. 

4. Unscrew the inlet and outlet ports from the flow cell and rinse with additional water.  Then pump 

through a stream of nitrogen or other nonhazardous dry gas to dry them thoroughly.  Set the dried 

ports on a clean lint-free surface to avoid contaminating the ends. 

5. Very carefully, using a slotted screwdriver, unscrew the flow cell assembly from the rotating stage 

of the SPRimager®II. 

6. Bring the flow cell assembly to a clean surface.  Holding it flow-cell up, loosen and remove the 

four screws.  Rinse the flow cell, O-ring and O-ring groove with pure water, then dry them with a 

stream of nitrogen or other nonhazardous dry gas.  Store covered at room temperature. 

 


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7. Place the flow cell assembly prism-side up on a clean surface.  Loosen the thumb screw that holds 

the prism wedge in place and remove the wedge.  Holding the prism by its two non-polished sides, 

remove it from the holder. 

The chip most often comes off attached to the prism face, but you should be prepared for the 

chip to slip off the prism as you are holding it, so work over lens paper.  If the chip clings to 

the prism surface, gently nudge the edge of the chip with tweezers to separate it from the prism.  

If the chip does not readily move as you nudge it, a small amount of ethanol will loosen it.  Be 

prepared to grab the chip with tweezers as it slides off the edge of the prism. 

8. Optional step if you wish to re-use the chip:  Holding the chip with tweezers on the glass margin, 

rinse the glass surface first with ethanol to remove any residual matching fluid, then with distilled 

water.  To prevent these liquids from touching any probes on the gold side of the chip, you may 

prefer to clean the glass surface using a moistened Q-tip®. 

If this is a DNA-probe chip, you may clean the probe surface by rinsing it in water.  Store the 

chip covered, in a dry location at room temperature. 

SPRchips are warranted for single use only.  However, some users have found that DNA probe 

arrays and some protein arrays can be re-used if care is taken in handling the SPRchips 

between uses.  Protein arrays are best stored refrigerated in buffer without glycerol. 

9. Clean the prism by dragging an ethanol soaked piece of lens paper across each surface until dry as 

described on page 7.  Store prism covered, resting on one of its non-polished sides. 

 

 

Troubleshooting  

BUBBLES OR LEAKS IN THE FLOW CELL 

Whenever you are viewing a Live Image you can watch for air bubbles in the flow cell.  If you see 

bubbles forming in any region of interest, turn the pump on high and pinch the flexible input tubing 

close to where it connects to the flow cell.  Let the pressure build up for  a few seconds and then 

release the tubing.  Repeat as necessary This usually ejects the bubble through the output tubing.  If 

bubbles are not removed promptly, they may leave residues on the chip surface. 

One cause of bubble formation may be inadequate tightening of the flow cell.  If the O-ring is not fully 

compressed tightly against the slide, pockets of air can be trapped between the flow cell and the 

incoming liquid when it is first filled.  If the bubble problem persists, or if you see liquid dripping out 

of the flow cell, remove the prism/slide assembly from the rotating stage of the SPRimager®II and 

tighten the four screws that hold the flow cell in place.  Other possible causes of bubble formation 

include residual moisture, either in the pump tubing, flow cell openings or input/output ports.  

Therefore, be sure to dry lines and ports thoroughly before remounting. 

MAKING SURE THE SPRCHIP™ IS ORIENTED CORRECTLY 

The SPR effect will be created only when the SPRchip is mounted into the prism assembly with the 

gold surface facing the flow cell.  If you are new to SPR analysis, you may not immediately recognize 

the correct orientation for the SPRchip™.  There are two ways to ensure you orient the chip correctly: 

 SPRchips are always packaged with the gold surface down.  Therefore if you remove the SPRchip 

from its package only when you are ready to assemble the chip into the flow cell, you will be able 

to keep track of the chip orientation. 







 18 

 If you have lost track of the chip’s orientation in the package, hold the chip firmly in the supplied 

forceps and hold it up to the light, looking down obliquely on the edge.  When the gold surface is 

uppermost, you can easily see the edge of the gold coating from above at this angle. 

SpotReady™ chips are readily oriented due to the inclusion of an orientation spot.  Simply orient the 

chip so the orientation spot is in the top left corner to ensure the gold side is up. 

TEMPERATURE REGULATION 

The SPRimager®II can be operated at ambient temperature for many different applications, such as 

nucleic acid hybridization.  If you plan to operate the SPRimager®II at ambient temperature, you 

should set the temperature control several degrees below ambient temperature rather than precisely at 

ambient temperature.  The SPRimager®II does not have cooling capability, so setting the temperature 

near to ambient may cause the heater to operate occasionally, compromising temperature control. 

To operate the SPRimager®II above ambient temperature, make sure the temperature sensor is 

screwed firmly into the flow cell frame (page 6) before you turn up the temperature controller. 

If you turn up the temperature prior to attaching the temperature sensor, the heater will 

operate but the temperature sensor will continue to register the ambient temperature where the 

temperature sensor is placed, causing the flow cell to overheat and possibly burning out the 

heater element. 

If you do accidentally overheat the flow cell, turn the temperature controller down below ambient, 

ensure the temperature sensor is correctly attached, then wait for the temperature to return to ambient 

before continuing. 

NON-UNIFORM IMAGE BACKGROUND 

Because the SPRimager®II calculates SPR response using difference images, minor non-uniformity of 

the chip surface is largely inconsequential.  However, major non-uniformities—such as bubbles or 

smears—can be a problem.  Bubbles can usually be removed as indicated on page 17.  Smears and 

other surface defects can be avoided by maintaining a clean environment during chip fabrication and 

by handling the chips carefully, avoiding contact with the probe surface. 

LOW SPR SIGNAL 

Many factors can affect the SPR signal strength, ranging from misalignment of the prism angle to 

defective surface chemistry on the chip.  This section deals solely with potential instrument problems.  

To investigate potential SPR response problems, check the following: 

 Is there light originating from the light source to the left of the rotating stage?  If there is no light, 

the bulb may be defective.  If there is light, check to see if you can elicit the SPR response as 

follows. 

1. Assemble a gold-coated SPRchip™ or SpotReady™ chip into the sample cell and mount in the 

SPRimager®II as described on page 7. 

2. Pump water into the flow cell. 

3. Start V++ then click the Line Profile macro button to launch the GWC Line Profile program.  In 

the left Line Profile window, you should observe the outline of the flow cell.  Observe if you can 

elicit the SPR response (i.e. reduce the light reflected to the camera) in the gold area(s) by rotating 

the prism angle (see page 10).  If you cannot reduce the reflectivity, check the following: 

 Is the chip assembled so that the gold coating is exposed to the liquid in the flow cell? 

 Is the polarizer set to the uppermost p-polarized and not rotated 90° to the s-polarized position? 


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If you have checked these items and still do not observe a reduction in reflectivity in the Line Profile 

program, please contact your service representative. 

 

Angle adjust screw 

Polarizer adjuster 
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Additional Experimental Designs 

MEASURING INTERACTION AFFINITIES 

Affinity measurements for specific molecular interactions may be made by extension of the above 

difference image technique.  One of the molecular partners is immobilized as probe on the chip surface, 

the other is flowed through the flow cell as analyte.  The experiment is performed for a series of 

increasing concentrations of analyte, allowing the analyte to reach equilibrium binding each time.  The 

signal changes for each concentration are then calculated from a series of difference images obtained 

by subtracting the reference image from the image obtained at each concentration of analyte.  

Reflectivity changes are then plotted versus concentration of analyte.  The plateau in signal is 

considered to be 100% surface coverage, and affinities can then usually be detemined by fitting the 

resulting curves to Langmuir isotherms, using the classical Langmuir equation: 

where Kads is the adsorption coefficient, equivalent to the equilibrium association constant KA for 

solution measurements, and  is the surface coverage.  (The surface equivalent of the equilibrium 

dissociation constant, KD, is the reciprocal of Kads.)  The experiment below shows published data 

obtained by SPR imaging for measurement of affinities of two different peptides for the same antibody: 

Langmuir isotherms for the same 

antibody binding to two different 

synthetic peptide epitope probes, 

as determined by Surface plasmon 

resonance imaging.  The right 

scale shows the change in percent 

reflectivity measured by SPR 

imaging, the left scale indicates 

the fraction of probe surface to 

which antibody bound.  The 

mutant “F4” peptide did not bind 

as well as the wild-type “F1” 

peptide.  Kads (the surface-binding 

equivalent of KA) values measured 

were 1.5x10
8
 M

-1
 for F1 and 

2.8x10
7
 M

-1
 for F4.  Reprinted 

with kind permission from 

Analytical Chemistry:  Wegner et 

al., Vol 74(20), 5161-5168, 2002.  

Copyright © 2002, American 

Chemical Society. 

 

MONITORING CHANGES OVER A TIME COURSE—A SIMPLE 1% ETHANOL TEST 

For collection of many data points over a significant time course, data handling becomes cumbersome 

and data storage capacity for images collected may strain available resources.  To simplify data 

collection over a time course, Macros are provided in V++ that allow you to collect images and 

process intensity changes in real time, with data transferred to a linked spreadsheet.  To save disk 

space, you may opt not to save individual images for each time point. 

Kads =  / C (1 - )
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The following experimental outline may be used for any time course data collection experiment.  For 

the purposes of illustration, the following procedure simply measures the change in SPR signal that 

occurs when replacing distilled water with a 1% ethanol solution in the sample cell.  SPR signal 

changes in this case because the refractive index of 1% ethanol (1.3336) is higher than the refractive 

index of water (1.3330).  This is a simple way to confirm that the SPR system is operating correctly, 

independent of any problems that might arise through surface probe attachment or analyte binding in 

the type of experiment most users normally want to do.  The protocol may readily be applied to any 

probe-analyte experiment for real-time data collection. 

For this procedure, since no surface-bound probes are involved, you may use an unmodified gold chip 

or you may use a chip derivatized with surface chemical layers.  You could even use a chip with 

surface probes bound from an earlier experiment, provided the surface remains smooth and clean. 

The experimental approach is to define ROIs on the image corresponding only to those areas whose 

reflectivities you wish to monitor.  The provided macro in conjunction with V++ and Microsoft® 

Excel® will then collect images at intervals you specify, calculate differences in reflectivities for each 

ROI using a time zero image as a reference, and plot the data in Excel as the experiment progresses. 

Before proceeding, be sure you have completed steps 1through 6 of the section How to Use Your 

SPRimager®II, beginning on p 5.  Start the experiment with a SpotReady™ chip mounted on the 

instrument and the flow cell filled with pure water. 

1. In V++, click the Acquire average image Macro button (as shown at left).  When prompted for the 

number of images to average, type in 30 then choose OK.  This generates an image of the array 

mounted on the instrument. 

The more images averaged per data point, the better the signal-to-noise ratio but the longer it 

takes to acquire each data point.  Averaging 30 images per data point typically takes just 

under 4 seconds.  If you want to collect data points more frequently, reduce the number of 

images averaged. 

2. Click the Select ROI button from the V++ toolbar (as shown at left) to activate this tool.  Hold 

down the shift key on the keyboard, then Click-Drag-Release to draw region(s) of interest (ROIs) 

on your chip image.  Be sure to hold the shift key down until you have finished drawing ROIs. 

The size in pixels of the ROI 

you are currently drawing is 

displayed in the bottom right 

status bar of the V++ 

window.  To make an ROI of 

a specific size, hold the 

mouse button down and 

adjust the size until the 

measurement in the status 

bar is precisely the size you 

want. 

To add multiple ROIs to the 

same image without having 

to hold down the shift key, 

from the V++ Tools > 

Options menu, check the 

box beside “Persistent ROI Definitions”.  If you choose this option and wish to remove the 

ROIs, select Tools > Attachments and either click on the checkbox to turn off display of 

the ROIs or Delete the ROIs list.   If you want to delete the most recently drawn ROI, press the 

Backspace key. 

A SpotReady™ 16 chip imaged in V++, with a rectangular 

ROI drawn on each of the 16 spots (but not on the leftmost 

orientation spot). 
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The order in which you draw ROIs determines the order in which values such as the average 

instensities and standard deviations will be reported. 

3. Choose File > Save to save this image with the 

ROIs on it.  You might call it ―Mask.tif‖, since 

this image will serve as a mask (it masks regions 

outside the ROIs).  Choose a convenient location, 

such as the C:\SPR-DATA\ folder (if not present, 

this folder is created the first time you run the Time 

Series Macro).  Be sure to maintain the TIF format for 

this file.  Do not close the image after saving it, as 

your system needs to refer to this image while 

collecting data. 

4. In V++, check that the nine buttons for the added 

GWC functions are available on the toolbar.  If they 

are not, follow steps 3-7 in the section ―Install the 

GWC Macro module for V++‖ (page 48). 

For this procedure, a series of images will be acquired over a time-course, as one might do to 

measure the course of a binding experiment.   

5. Launch Microsoft Excel if it is not already running, and open the template TimeSeries.xls.  

This is normally stored in the C:\SPR-Data\ folder.  Note that this is a read-only file, to prevent 

accidentally writing over the file.  In Excel, choose File > Save As and save this file under 

a new name in a convenient location. 

6. Return to the V++ program and click on the ―TimeSeries‖ Macro button in the toolbar (shown at 

left). 

7. When prompted to select a mask image with multiple ROIs, select the image with the mask that 

you created in step 3 of the prior section.  If your mask image is the only one open in V++, it will 

be the only one listed.  Choose OK to confirm this is the mask image. 

This step is included because V++ can open many image windows at once. 

8. When prompted for the number of frames per image, type in 30 again then click OK. 

9. When prompted for the delay in seconds between averaged images, type in 0 then click OK. 

This delay helps you avoid collecting too many images when the time course over which you 

want to take measurements is long.  Note that acquiring 30 images takes a little less than 4 

seconds, so with zero delay between average images, measurements will be taken 

approximately every 4 seconds.  To acquire images more frequently, average fewer images.  

The exact timing of image acquisition will be entered in the spreadsheet in seconds. 

10. When asked whether to Save realtime images?, click No. 

For this experiment, where there are no differences 

expected on the chip, the images would be uninteresting.  

However, when you have different probes on the chip that 

may react at different rates with the analyte, it is often 

illuminating to be able to “play back” the images in 

video mode to get an overview of how the molecular 

interactions progress over the course of your experiment.  In order to use play back mode, it is 

necessary to save the realtime images. 
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Note that if you do choose to save realtime images, you will be prompted for a prefix name for 

all the images.  The images are then automatically saved under a series of names each 

commencing with the prefix you choose. 

11. You will next be asked whether you want to ―Take ref image now.‖  Click Yes. 

Once you click Yes, a reference imagewill be acquired, and the intensity values for each ROI 

on your reference image will be added to the data window and to the Excel spreadsheet (the 

first column in each data set is the time in seconds).  The values in this first row of data are 

average absolute values at each ROI.  The subsequent values are the results of subtracting this 

first ROI value from each subsequent value. 

12. Now you will be asked if you are ―READY TO GO???‖.  This is a pause in the macro that allows 

you time to set up any last-minute experimental adjustments (such as turning on the pump) and if 

necessary confirm that the Excel spreadsheet is loaded before data acquisition commences.  Be 

sure you are ready to go before proceeding. 

13. Ensure you have ample water in the analyte reservoir, then turn on the pump switch and set the 

pump speed regulator to the fully clockwise position.  Then click the Yes button.  Data collection 

now commences.  Collect data for 1-2 min with the water pumping through the flow cell. 

As data are collected, they are entered into sheet 1 of the Excel spreadsheet.  If you want to 

monitor the data on a graph during collection, switch to viewing the Excel spreadsheet.  You 

will see a chart created as data are transferred from V++ to Excel.  These data are the results 

of measuring the reflectivity of each ROI and subtracting from these values the reflectivity of 

the corresponding regions of the reference image. 

 

Initial data in Excel vary only 

slightly, reflecting system noise. 

Note that only data for the first 

three ROIs are plotted, however 

data for all are collected. 
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Note that initially, the distinct time points show slightly different reflectivities.  The differences 

look large because the chart in Excel autoscales the y-axis, so system “noise” appears 

significant, as illustrated in the Excel image below.  However, this noise level will appear 

small when you measure a genuine signal. 

Troubleshooting tip:  When you want to perform an action such as pausing the data collection, 

you must make V++ the active program.  If you forget and leave Excel as the active 

application, your keystrokes will not be registered by V++. 

The next step is to replace the water in the flow cell with 1% ethanol and measure the increase 

in SPR signal.  This involves  pausing data collection, turning off the liquid flow, switching the 

flow supply tubing to the 1% ethanol reservoir, restoring the liquid flow,, and measuring the 

increased signal. 

14. To pause data collection, make sure V++ is the active application, then simply press the ―P‖ key 

on the keyboard. 

Pressing “P” pauses the transmission of data from V++ to Excel, but does not stop the 

“clock” recording time.  Pressing the “P” key is a “toggle” in this context—when you are 

ready to restart, simply press the P key again.  Data  transmission to Excel will now resume. 

15. Turn off the liquid flow by rotating the pump regulator fully counterclockwise. 

16. Remove the input tubing from the water reservoir and transfer the end of the tube into a reservoir 

with 1% ethanol in pure water. 

17. On the SPRimager®II, rotate the pump controller clockwise to its prior position to restart the 

liquid flow, then on the keyboard press the P key to restart the paused Macro and resume 

collecting data.  Collect data for 1-2 min with the 1% ethanol pumping through the flow cell. 

Be sure top avoid introducing air bubbles into the flow cell when changing liquids.  The pump 

should always be off when you move the tubing from one liquid to another. 

If you wish, you may again monitor the SPR signal during data collection by viewing the Excel 

spreadsheet.  The SPR signal will begin to increase within a few seconds of turning the pump 

back on again. 

The next step is to replace the 1% ethanol in the flow cell with water.  This will cause the SPR 

signal to return to its original baseline. 

18. To pause data collection again, ensure that V++ is the active application then press the P key on 

the keyboard.  Rotate the pump controller fully counterclockwise to turn the liquid flow off. 

19. Remove the input tubing from the 1% ethanol reservoir and transfer the input tubing into a 

reservoir of distilled water. 

20. On the SPRimager®II, turn the pump back on, then press the P key on the keyboard to restart data 

collection.  Collect data for 1-2 min with the water pumping through the flow cell. 

21. To stop (rather than pause) data collection, ensure that V++ is the active application then press the 

Escape key on the keyboard.  Turn off the pump.  You will receive two further prompts from V++:  

When prompted ―Print data to text file???‖, choose No.  When you receive the FINISHED! 

notification, click OK. 



  




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You don’t need to save the V++ data to a text file because the data are transferred to Excel, 

where you will save them in the next step.  However, you may save the data as a text file in 

V++ as a backup if you wish. 

22. On the computer, switch to Excel and choose File > Save to save the data you just collected. 

A plot of data collected in this way is shown below for one ROI.  The delay in signal changes 

from water to ethanol reflect the time taken to exchange the fluid in the flow cell.  This is a 

useful guide to the time needed to replace one analyte for another one at a given pump speed 

setting. 

When you return to V++ and Exit the program, you will be prompted to Save data that V++ 

has collected.  This includes the text file of the ROI intensities and any images you created but 

did not save.  In this example, you probably do not want to save the V++ data, as the same 

data have been transferred to Excel. 

23. If you wish, you can use the ethanol signal to calibrate the SPRimager®II.  A 1% w/v ethanol 

solution at 20° has a refractive index of 1.3336, whereas the refractive index of water is 1.3330.  

Therefore, the change in SPR signal recorded corresponds to a refractive index change of 0.0006.  

Thus, if the change in reflectivity observed for 1% ethanol is 16 pixel intensity units (PIUs), then 1 

PIU corresponds to a change of 0.0000375, i.e. 3.75x10
-5

, in refractive index.  In a typical 

experiment, you should be able to measure differences of 0.5 PIU. 

SEQUENTIAL BINDING EXPERIMENTS 

You may want to monitor changes in analyte binding to probes under a variety of sequential 

conditions, such as monitoring the binding of a calcium-dependent interaction in the presence of 

calcium, then monitor dissociation when the calcium is removed.  Or you may want to monitor 

binding of multiple rounds of different analytes, for example to determine whether one protein binds 

to your probes only when some other molecule is first bound. 

To monitor sequential binding, simply collect images as follows: 

1. Collect a first ―Reference Image‖ of the array in buffer prior to exposing to any analyte. 

2. Expose the array to analyte 1 then collect the first  experimental image, image 1. 

3. Expose the array to analyte 2 or condition 2, then collect the second experimental image, image 2. 

SPR Signal Change:  Water / 1% Ethanol / Water
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Additional exposures to other analytes or conditions may be added to this scheme. 

 To determine the extent of binding of analyte 1, create the difference image [image 1 minus 

reference image]. 

 To determine the extent of binding of analyte 2 to the complex of probe with analyte 1, create the 

difference image [image 2 minus image 1]. 

Several rounds of  such incremental binding events may be monitored, and the changes may be 

positive (increased binding) or negative.  Simply be sure to maintain a constant prism angle during the 

entire experiment to enable the difference images to be properly quantified. 

OPTIONAL CONVERSION OF DATA TO REFLECTIVITY CHANGES 

The SPR signal change obtained as the PIU (above) may be converted to the real change in 

reflectivity, %DR.  Converting data to %DR can be useful because it is an absolute physical unit of 

measurement.  To convert your results to %DR: 

1. Rotate the polarizer adjuster (see picture at 

right) 90° left or right to change the 

polarization of the light from ―p‖ to ―s‖. 

Since there is no SPR response to s-

polarized light, all of the light will now be 

reflected off the gold surface, and the CCD 

image for these regions will be white. 

2. Without making any adjustment of the 

angle of the prism, place a neutral density 

filter in front of the polarizer to reduce the 

light energy reaching the prism, then 

collect one image by clicking the Acquire 

Average Image macro button (pictured left).  

Choose to average the same number of images you averaged for the experimental data points.  The 

image now generated is the s-polarized image, which will be white or gray. 

If 100% of the s-polarized light reached the CCD camera, it would saturate the detector, and 

the signal would thus not be accurately measured.  A filter that reduces the light energy to 

25% of normal level is about right, though you can use higher density filters if you wish. 

3. Now click the Average macro button (pictured left).  V++ 

will then prompt you to select two images.  First, select the 

mask image, i.e. the one on which you created the ROIs, 

that your Time Series Macro used to determine the areas 

from which to collect reflectivity 

data.  Second, select the s-

polarized light image that you just 

created.  V++ will now generate a 

text window containing 

reflectivity data for each ROI on 

the s-pol image, in the order you 

created the ROIs on the mask 

image. 

4. Copy the data in the text window and paste into an Excel spreadsheet for adjustment of data 

to %DR, using the following formula: 

 

 

 

 

Angle adjust screw 

Polarizer adjuster 
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Absolute Δ%R = 100 * ((SPR sample pixel difference * 0.85) / (s-pol pixel intensity / (1-d)) 

where d is the density of the filter used.  For example, if you used the recommended filter that 

transmist only 25% of the light, d = 0.75. 

Be sure to return the polarizer control to the uppermost position to restore the source to p-

polarized light before the next experiment.  If you leave the polarizer at the “s” position, no 

SPR response will be generated. 

 

 

 

 

FEATURES OF THE NINE V++ MACRO FUNCTIONS PROVIDED BY GWC 

Each of the nine functions is executed by clicking one of the nine Macro buttons, pictured 

above.  Most of these functions could be executed within the standard V++ program, but using 

the provided macros saves time and effort. 

Line Profile Macro 

A line profile is a linear graph of image intensity corresponding to a line that you draw on the image.  

This GWC Line Profile function differs from the line profile available in V++ in that it gives you a 

live image that continually refreshes.  This is useful when you want to set the angle of the incident 

light prior at the beginning of each experiment. 

To use this Macro, click the Line Profile button then draw a line on the image corresponding to the 

section you want to monitor.  When you adjust the angle of the prism assembly on your 

SPRimager®II, the change in intensity will be displayed on the screen in real time. 

The Line Profile macro launches the GWC Line Profile program from within V++.  However, 

since the Line Profile program communicates directly with your Video capture board, you 

cannot acquire an image in V++ at the same time you are using Line Profile.  Therefore, be 

sure to exit the Line Profile program before you try to acquire an image in V++. 

Acquire Average Image Macro 

This macro creates an averaged 32-bit image from the current image;  you specify how many frames 

you want averaged to create the average image.  The 32-bit images created can be opened in many 

other programs. 

Note: The displayed averaged image is in 32-bit format. The imaging camera is itself 8-bit, but 

to avoid loss of accuracy all averaging and math operations are performed after converting 

the captured images to 32-bit format.  To convert images back to 8-bit, see the next section. 

Convert to 8-bit Image Macro 

Sometimes you may want to convert the 32-bit images captured in V++ to 8-bit, for example if you 

want to analyze them in another program that does not recognize 32-bit images.  This macro creates an 

8-bit version of the current image in a new image window, which you can then Save under a new 

name. 




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SPR difference images can include negative numbers, which are not allowed in 8-bit image 

files.  This macro normalizes the data before conversion:  it finds the negative number of 

highest magnitude, then adds this value to all the pixel intensity values in the image file. 

You may convert imags to other file types using the V++ Tools > Convert Type menu.  

The File > Save As command gives you several options for alternative formats. 

TimeSeries Macro 

This macro automates the setup for capturing a series of SPR images over a time course and 

subtracting the initial background image from all of them.  Prior to using this macro,  a series of setup 

options should first be chosen, as follows: 

 Prior to starting the macro, you need to capture a sample image, then on this image define a 

number of selected regions-of-interest (ROIs).  This image window must remain open in V++ 

while the TimeSeries macro is running. 

 The averaged intensity over each of the defined ROIs are transferred to an Excel file using 

Windows DDE.  An Excel template is provided (C:\SPR-DATA\TimeSeries.xls).  An 

Excel file must be open that contains a default worksheet named ―Sheet 1‖, an error occurs if this is 

not available when you try to run the macro. 

The Excel spreadsheet has two worksheets, “Sheet1” and “Chart1”.  In Sheet1, only values 

for the first four ROIs are plotted.  In Chart1, values for all ROIs are plotted.  However, you 

should not make Chart1 the active worksheet when collecting data with the TimeSeries 

Macro—the extra computing time needed to calculate and display all the data may cause data 

loss if you are monitoring many ROIs at once. 

 ROI intensities are extracted from averaged images. During macro setup you will be prompted for 

the number of frames to average per time point and the time delay between image data capture (that 

is the additional delay over the time needed to capture the averaged image).  For example, if you 

choose to average 30 frames per image and enter zero delay, there will be a gap of almost 4 

seconds between consecutive images. 

 You can choose whether to save averaged images captured during acquisition:  saving them gives 

you the option of viewing them as a movie in the Playback macro (p 29).  If you save averaged 

images while acquiring data then the images are stored in the folder C:\SPR-DATA\rootname 

where rootname is the name you enter in the type-in box that prompts you for the name of the 

data series.  Numbers are appended to this rootname to create a series of unique filenames. 

 During data acquisition, keyboard inputs are recognized while the V++ window is active.  If you 

are monitoring your Excel data during data acquisition, be sure to make V++ the active program 

window before typing any of the following keyboard inputs: 

 Esc = stop and close macro 

 p = pause data collection (press p to continue) 

 d = delay – change delay time between image acquisitions. 

 a = average – change number of images over which averaging is performed. 

 After you stop the macro you will be prompted to ―Print to data file?‖.  If your data are captured in 

Excel and saved, there is no need to Print the data to file, though you may do so as a backup if you 

wish. 

FastTimeSeries Macro 

Like the TimeSeries macro, this macro also simplifies the setup for capturing a series of SPR images 

over a time course and subtracting the initial background image from all of them.  The purpose of this 

macro is to capture consecutive images as quickly as possible.  To achieve this speed, several 

processes performed by the standard TimeSeries macro are eliminated:  FastTimeSeries captures 

single images and saves them immediately to the hard drive—there is no image averaging, and no 


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added time delay between consecutive image captures.  Of particular note, the following events do not 

occur: 

 Displaying the image data on the screen 

 Sending data to Excel 

 Processing of ROIs 

Since there is no ROI processing for the FastTimeSeries macro, you do not need to provide an 

image with ROIs already drawn;  this macro instead saves the entire image and writes it to a 

file for every time point.  You can then process the data set later using the Playback Macro. 

Playback Macro 

This macro allows you to analyze selected ROIs on a series of captured images.  There are two 

situations where this may be especially helpful 

 When you captured image data using the FastTimeSeries macro, which does not perform any 

image analysis; 

 When you want to re-analyze a set of data using ROIs different from the original set you 

analyzed.  Note that you must save the images from the Time Series macro to use this option. 

Thus, when you use the Playback macro, you need to supply an image with ROIs drawn on it, plus you 

need to supply a reference image for background subtraction.  If you draw ROIs on your reference 

image, you can use the same image for both purposes. 

Average Macro 

This macro generates a text report listing the average intensity value for the pixels in the area of the 

ROIs drawn on the current image.  Values are listed in the order the ROIs were drawn.  You may copy 

the list of averages and paste the data into a spreadsheet or other program via the clipboard. 

Standard Deviation Macro 

This macro generates a text report listing the standard deviations of the average intensity values for the 

pixels in the area of the ROIs drawn on the current image.  Values are listed in the order the ROIs 

were drawn.  You may copy the list of standard deviations and paste the data into a spreadsheet or 

other program via the clipboard. 

Version Number Macro 

This macro displays the version of the GWCmodule you are running.  Should you need to contact your 

service team regarding the V++ module functions, you will be asked for this version number. 

 

 

 

HINTS FOR USING THE V++ SOFTWARE FOR DATA COLLECTION AND ANALYSIS 

The V++ software is documented in the Digital Optics Ltd. V++ manual supplied with your system, 

and in the V++ on-line help menu.  The following notes are included to help you get started using the 

V++ software with the SPRimager®II. 

Toolbar Buttons Versus Menus 

Many commands in V++ are accessible via the menu system and via the toolbar buttons.  It’s your 

choice.  To view buttons for specific functions, right-click on the toolbar area, choose Customize, then 

select the button groups you want. 
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Selecting Specific Regions of the Chip for Analysis:  “Select ROI” 

―ROI‖ means Region Of Interest.  Typically, when analyzing chips, you want to capture SPR signal 

changes in the regions where your probes are attached, but not elsewhere.  To specify any ROI, click 

on the Select ROI button (pictured left) then hold down the mouse and drag a rectangular area around 

the region you want. 

To select multiple ROIs, hold the Shift key after drawing the first ROI while you draw the rest of the 

ROIs you want.  To remove all selected regions, simply click the mouse once on the image. You can 

deselect regions one by one (in reverse order of selection) using the Back Space key while the Select 

ROI tool is active.  Alternatively, from the Tools > Options menu, you may check the box beside the 

Persistent ROI definitions option, in which case you will not need to hold down the shift key to draw 

multiple ROIs.  If you choose this option and wish to remove the ROIs, select Tools > Attachments 

and either click on the checkbox to turn off display of the ROIs or Delete the ROIs list. 

Placing and Removing Flags 

Flags are small cross symbols that may be placed on an image to identify locations for a variety of 

image processing operations.  For example, you may place flags to indicate the path for an intensity 

profile or to locate control points for geometric mapping operations. 

One or more flags are added by first clicking the Flag tool then clicking on the image in the locations 

you want.  To delete a flag, click on it while holding down the Ctrl key.  You may also remove flags 

one by one (in reverse order of creation) by pressing the Back Space key while the Flag tool is active.  

Or, to delete all the flags on the image, select Tools > Attachments and either click on the checkbox to 

turn off display of the flags or Delete the flag list. 

Assessing Image Quality:  Image Statistics 

This V++ command calculates the minimum, maximum, mean, and standard deviation of pixel 

intensities for the current image or, if present, the first in the series of ROIs.  Many users find this 

helpful for a quick overview of overall image quality and data range.  To obtain the statistics for the 

whole image or selected ROI, either click the Statistics button (pictured left) or choose Intensity > 

Statistics from the menu. 

Displaying Image Intensity with Row and Column Plots 

Row and Column Plots can be used to show pixel intensities graphically.  A row plot shows the 

intensity variation in one or more horizontal boxes across the image and a column plot indicates the 

intensity variation in one or more vertical boxes through the image.  To use these plots, choose 

Intensity > Row and Column Plots, then select the options you want (there is no toolbar button for 

these plots): 

 Direction determines whether a row or column plot is required 

 Input selects the input data area, which may be the whole image, flagged rows or columns, or the 

regions of interest (ROIs). 

 Calculation selects the statistical calculation to be performed on the image data for plotting.   

The image below shows a rectangular ROI drawn on a difference image (left panel) and its 

corresponding column plot (right panel). 
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The x values on these plots correspond to the x or y pixel coordinate along the row or column 

respectively.  To move the data underlying these plots to another application, make the plot the 

active window, then choose Edit > Copy, or simply right-click on the plot then click on Copy.  

This places the data in text format onto the clipboard, from where you may paste the data to 

another application. 

 

Manipulating Images using the Math functions:  Image Subtraction 

You can apply mathematical functions to one or more images in V++.  For SPR imaging, the most 

common application of the Math functions is image subtraction in the Math > Arithmetic submenu.  In 

step 6 of the simple experiment described on page 22, the TimeSeries macro uses this subtraction 

function in V++ to capture the data you want—that is, subtracting the time zero image from all 

subsequent images.  Sometimes you may want to subtract an image other than the time zero one from 

another image.  Direct access to the subtraction function is useful in such cases. 

To use the Math functions, be sure to open the image(s) you want to manipulate, then choose Math 

from the main menu.  Most of the time you will want to use options in the Math > Arithmetic submenu, 

also accessible via the toolbar button. 

Evaluating Multiple Images Using the Sequence Functions 

In V++, a Sequence is a series of images, referred to as frames, ordered in time or position.  In a time 

sequence, each frame is a snapshot of action at a particular time.  In a sequence ordered by position, 

each frame represents a slice of data at a particular depth through an object or scene.  A single image 

has an x dimension (width) and a y dimension (height),whereas a sequence has an additional z 

dimension representing depth or time.  The first frame has the coordinate z = 0. 

The Sequence functions enable you to analyze a group of images rather than one image at a time.  You 

may also export a sequence from V++ as a Windows AVI file, which you can then play back in other 

applications such as Microsoft Windows Media Player or Powerpoint®.  This is an excellent way to 

show how various binding activities progress over time.  You may also apply statistical functions to a 

Sequence, for example to improve signal-to-noise ratios by averaging a series of images.  These 

functions are accessed via the Sequence > Ensemble Statistics option. 
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Single images are considered to be sequences with only one frame.  To add frames to any image to 

turn it into a sequence, choose Sequence > Add Frames then select the options you want in the dialog.  

Sequences may be of any image type but all the frames for a given sequence must be the same type 

and the same size. 

Converting Image Types 

The camera in your SPRimager®II captures 8-bit images.  However, the V++ macros that average 

multiple images convert the images to 32-bit prior to averaging them—this is necessary to maintain 

precision of averaged images.  When you save such average images, they are saved in 32-bit format. 

The Tools > Convert Type command in V++ performs image data type conversions.  For example, 

you may convert a 32-bit image to an 8-bit image so that the image may be read by other general 

purpose graphics programs. 

It is important to note that 32-bit images should be scaled before converting to 8-bit type so 

that the maximum pixel value is 255 and so that any negative values are removed—8-bit image 

formats do not allow for negative numbers. 

 

To convert 32-bit SPR images to 8-bit images 

1. Make the image you want to convert the active image in V++. 

2. Find the minimum pixel value of the image you want to convert by choosing Intensity > Statistics.  

If the minimum value is zero or higher, you do not need to scale the image and may proceed to 

step 4.  If the minimum value is negative, proceed to step 3. 

3. Convert the negative minimum pixel value to a positive number and add it to the image by 

selecting Math > Arithmetic.  Type the value into the type-in box, click the radio button for Add, 

then click OK. 

For example, if the minimum pixel value  is -12, you would type the number 12 into the type in 

box.  Adding 12 to the image thus makes the minimum value in the image zero, and no data 

will be lost upon conversion to 8-bit. 

4. Now you may convert the image type to unsigned 8-bit.  Choose Tools > Convert Type and in the 

dialog click the type of image you want.  Click OK to convert the image, and choose a new name 

and location for it. 


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Guidelines for making probe arrays on gold chips 
The SPRimager®II measures changes in binding of analytes to probes immobilized on the gold 

surface of SpotReady™ or SPRchip™ substrates.  The quality and nature of the array are major 

factors in the success of any experiment designed to monitor molecular interactions.  A comprehensive 

review of the many different approaches used to make probe arrays is beyond the scope of this manual.  

However, the following guidelines will help new users understand which factors are most influential 

in guiding the success of array fabrication.  For detailed protocols for several types of array analysis 

experiments, visit www.gwctechnologies.com, or contact your GWC Technologies representative. 

Strategy for probe attachment 

A major decision in analyzing molecular interactions is preparation of the array, including preparation 

of the chip surfaces, and subsequent attachment of probes.  In order to make the best use of the 

SPRimager®II to study your molecular interaction you should consider: 

 What type of chip (SpotReady™ vs plain SPRchip™) is better suited for your experiment. 

SpotReady™ chips provide an easy way to get started, with 16 or 25 gold spots per chip.  You 

can make probe arrays with SpotReady™ chips by hand, so you don’t need robotic spotting 

equipment. 

SPRchip™ substrates offer plain gold surfaces on which you can array up to 500 or more probes 

per chip.  If you are making arrays with more than ~25 probes, you will need a spotting device to 

put the probe solutions on the surface.  Depending on your surface chemistry choices, you may 

also need to use photopatterning (e.g. US Patent # 6,127,129;  Brockman et al., 1999) to prevent 

the spread of aqueous probe spots on the chips. 

 Which of the molecules in your interaction will be the probe bound to the surface of the chips 

and which will be the analyte(s) flowed over the chip surface. 

Two major factors that influence this decision are stability of the molecules and their size: 

Stability:  Peptides, oligonucleotides and sugars are readily immobilized on the gold chip surfaces 

and may be dried without loss of activity, whereas proteins require more careful handling to 

preserve activity, which is often lost upon drying. 

Size:  Larger molecules are detected more readily (on a molar basis) than smaller molecules.  If 

the affinity of the interaction is low, it may be helpful to design the experiment with the larger 

molecule as analyte and smaller molecule as probe. 

 Which of the many available chemistries you will use to attach your probe to the gold surface 

of the chip. 

The most popular approach to immobilizing probes on gold surfaces is via alkane thiol 

monolayers.  SpotReady™ and SPRchip™ gold surfaces are readily coated with alkane thiols 

simply by soaking the chips in a 1mM solution of alkane thiol in ethanol.  Many alkane thiols are 

available commercially, with varying alkane chain lengths and different functional groups for 

probe attachment.  Once the monolayers are prepared, there are then multiple ways to attach 

probes.  For example: 
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Direct attachment to alkane thiol monolayers:  If the functional group on the monolayer surface 

reacts with your probe, you may spot probe solutions directly on the monolayer.  For example, the 

alkane thiol DSO (dithiobis (succinimidyl octanoate);  see below) attaches to the gold via its thiol 

groups, generating an activated surface with exposed N-hydroxysuccinimidyl (NHS) ester groups 

that are highly reactive with free amines.  You may spot proteins directly onto such DSO-coated 

chips, whereupon free amines on lysine residues link covalently to the monlayer surface. 

Attachment via cross-linkers:  If the functional group on the alkane thiol does not react with 

your probe, or reacts inappropriately, you may use a cross-linker that has a reactive group for the 

monolayer and a different reactive group for your probe.  Cross-linkers also allow you to reduce 

the density of probe molecules—if the density of functional groups on the monolayer is so high 

that it may result in steric hindrance of the interaction you want to monitor, you can mix specific 

ratios of cross-linkers with and without the desired coupling functional group. 

Sandwich attachments:  To prepare a surface milieu compatible 

with optimal activity of your probe, it often helps to attach probes 

indirectly.  For example, protein probe acitivity can be enhanced 

by first attaching another protein which captures your protein 

probe.  A classic example, sketched at right, is attachment of a 

secondary antibody, such as goat anti-mouse antibody, to the 

monolayer.  You may then attach mouse antibodies to the goat 

antibody layer, in order to study how the mouse antibodies 

interact with specific antigens.  In this example, rather than attach 

the goat anti-mouse antibody to the coupler, streptavidin is 

attached to the coupler, then biotinylated goat anti-mouse 

antibodies are attached to the streptavidin.  For recommendations 

for this and other procedures, please contact your GWC 

Technologies representative. 

Additional Guidelines for Making Arrays 

Probe Size 

It is important to note that the SPR effect is observed for a distance above the gold surface of up to 

only ~200nm.  Moreover, the magnitude of the SPR effect for a given change in surface thickness is 

greater the nearer to the gold surface the change takes place.  This distance effect is negligible for most 

experiments.  The SAM-coupler layers together have a thickness of approximately 2 nm.  Proteins 
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typically have folded diameters of 5-10nm, so protein probes typically will not elevate binding 

reactions to a distance from the surface that significantly impacts sensitivity.  However, if whole cells 

(1,000 – 10,000 nm diameter or larger) or large viral particles are used as probes, most of the probe 

mass may be out of range of the SPR effect, and only analytes that bind to the small areas of such 

probes that lie within 200nm of the surface will be detectable. 

Guidelines for DNA Probe arrays 

DNA oligonucleotide probes for SPR are usually synthesized as single strands with a terminal thiol-

modified nucleotide for attachment to the coupler on the biochip surface (e.g. Nelson et al., 2002).  

Thiolated oligonucleotides are routinely available from commercial suppliers.  Alternatively, you may 

use biotinylated oligonucleotides, which may readily be attached to streptavidin surfaces.  However, 

the precision in predicting probe molecule density on the surface may be better for thiolated than for 

biotinylated probes. 

If dsDNA probes are desired, a complementary oligonucleotide sequence may be hybridized to the 

thiol-modified probe either before attachment to the chip surface, or afterwards by flowing the 

complementary strand over the chip surface (e.g. Kyo et al., 2004).  With the latter approach, the 

success of binding of the complement can be observed in real time on the SPRimager®II to confirm 

hybridization of complement to the probe, before further binding events are monitored when analyte is 

introduced into the flow cell. 

Binding of complementary DNA or protein to DNA probe arrays is typically reversible.  DNA or 

protein can be dissociated quickly from the probe with 8M urea solution, or more slowly with water.  

After rinsing the urea out with water, the probe array can be used for additional cycles of binding. 

Guidelines for Peptide and Protein Probe Arrays 

Synthetic peptides are commonly made with a terminal cysteine, which can conveniently be attached 

to coupling agents using thiol attachment chemistry (e.g. Wegner et al., 2002).  Improved binding 

activity may be obtained by adding three or more additional ―spacer‖ amino acid residues between the 

terminal cysteine and the main peptide sequence. 

For proteins synthesized from cloned genes, tags can be added to the protein to facilitate covalent 

linkage to couplers.  His-tagging has worked well for SPRimager®II experiments (e.g. Wegner et al., 

2003).  The Nickel-dependence of the His-tag / NTA reaction can be manipulated to release probes 

after they have been used for binding as a way of confirming the analyte binding was specific to the 

probe rather than the chip surface.  Many other attachment strategies are however feasible, since SPR 

detection operates independent of the surface attachment chemistry used. 

For proteins for which cloned genes are not available, or where native protein probes are desired, 

attachment to the surface is less straightforward.  Reagents are available for linking proteins via their 

free amines (e.g. Lahiri et al., 1999;  MacBeath & Schreiber, 2000), and cysteine residues or, for 

glycosylated proteins, carbohydrate groups have also been used.  These attachment methods are 

however quasi-random, and only a subset of attached probe molecules are expected to be presented at 

the surface in a way that they will bind specifically to analyte.  It is also worth noting that distinct 

orientations of proteins attached by these methods may bind with differing efficiencies or to different 

analytes. 

Whatever attachment method is used for proteins, it is usually desirable to prevent the protein from 

drying, which often causes denaturation. 

For further information, please visit www.gwctechnologies.com or contact your GWC Technologies 

representative. 
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Surface plasmon resonance as a function of angle of 

incident light.  Over a narrow range of angles, 

reflectivity falls, reaching a minimum at the “SPR 

angle”.  As molecules adsorb to the surface, the SPR 

angle shifts towards higher angles.  The greater the 

mass adsorbed, the greater the shift. 

Understanding Surface Plasmon Resonance 

SURFACE PLASMON RESONANCE DETECTION 

Surface Plasmon Resonance (SPR) measurements are surface sensitive methods used to characterize 

molecular layers on a noble metal surface (usually thin films of gold).  Surface plasmons (SPs) are 

electromagnetic waves, excited by p-polarized light, that propagate parallel to the gold surface.  SPs 

are transient, short range waves that have the maximum charge density very close to the surface;  they 

decay exponentially away from the surface.  SPR measurements utilize the optical field enhancement 

that occurs near the gold surface when SPs are created. The maximum decay length of SPs is about 

200 nm.  Within this 200nm region the optical fields are sensitive to changes in the index of refraction 

caused by changes in the thickness of the molecular layer on the gold surface.  Since the thickness is 

created by the number and size of the molecules attached or adjacent to the gold surface, SPR can be 

used to monitor molecular binding in the absence of any labels.  This is extremely valuable in studies 

of protein interactions, where molecular labels are often difficult to attach and where such labels may 

inadvertantly alter the characteristics of the protein.  As an added benefit, since both increases and 

decreases in thickness are readily detectable by SPR, both binding and dissociation may be measured 

using the same system, often in the same experiment. 

How SPR Imaging differs from Traditional SPR methods 

SPR measurements can be made using 

different methods.  One method, the angle 

shift measurement, employs a single 

wavelength of light for excitation and 

measures the reflectivity as a function of 

incident angle.  As shown at right, as the 

incident angle is increased, the reflected 

intensity is damped due to the creation of 

SPs.  The minimum in the reflected 

intensity is known as the SPR angle, the 

angle at which generation of SPs is 

maximized.   The position of the SPR angle 

and resonance curve shape are very 

sensitive to changes in the index of 

refraction at the metal surface, which in 

turn is influenced by changes in the 

thickness and/or index of refraction of any 

adsorbed material at the gold surface. 

GWC’s SPRimager®II uses a distinct method of SPR detection called SPR imaging.  While scanning 

angle experiments are used to study a single region on a gold surface, SPR imaging can monitor 

changes in the thickness on a gold surface in an array format.  This technique is very useful for the 

study of biological interactions where the simultaneous measurement of multiple interactions is 

desired in the context of robust experimental controls. 

In SPR imaging, both the angle of incidence and the wavelength are fixed.  In an SPR imaging 

experiment, the SPR effect is detected by measuring the light reflected from a sample illuminated at a 

fixed angle near the SPR angle.  The angle used by the SPRimager®II should be close to the 

maximum slope of the SPR curve in order to achieve maximum sensitivity. 

If the thickness of the sample increases, as when a molecule in solution binds to a probe molecule 

attached to the gold surface of the chip, the SPR curve is shifted as indicated at right.  Capturing the 
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SPR Imaging measurement:  The blue SPR curve 

shows the reflectivity profile before analyte binding, 

the red curve after binding.  The SPRimager®II 

measures reflectivity at a fixed angle (dotted line), 

generating a reflectivity difference, D%R, as 

indicated on the chart.  Typical SPRimager®II 

experiments measure reflectivity changes of 1-2% 

(0.01-0.02 on this chart) or less. 

 

SPR signal at the same angle of incidence 

before and after binding generates a reflectivity 

difference, D%R.  For an appropriate angle of 

incidence, the SPR signal is linear with respect 

to surface coverage provided D%R  10%.  

SPR imaging is thus most simply performed by 

taking two measurements: one before and one 

after binding.  The pre-binding signals are then 

subtracted from the post-binding signals to 

generate the image. 

GWC’s SPRimager®II. 

GWC’s SPRimager®II instrument is shown on 

page 39, and is summarized schematically 

below.  Light from a collimated polychromatic 

source passes through a polarizer and impinges 

on the prism/thin gold film/sample assembly 

(collectively the ―sample cell‖) at a specific 

angle near the SPR angle.  A rotation stage 

(blue circle) positions the  sample cell in the 

path of the polarized light.  The light interacts 

with the prism-gold interface, generating 

surface plasmons which in turn attenuate the 

light reflected from the surface.  The light 

reflected from the sample then passes through a 

filter which allows only a narrow bandwidth of 

light to fall upon the detector.  The detector in 

the SPRimager®II is a CCD camera, which 

captures an image of the entire optical field of 

the chip surface.  Images captured with the CCD camera are analyzed using the software and computer 

provided with the SPRimager®II. 

The sample cell is an assembly of a prism, a glass chip coated with a thin layer of gold to which the 

probe is attached, and a flow cell that allows analyte in solution to flow over the surface of the chip.  

The prism glass / gold interface is necessary for the generation of SPs and allows the light to be totally 

internally reflected thus optimizing the 

SPR response.  A peristaltic pump is also 

provided which is used to pump the 

analyte or wash solution from a reservoir 

into the flow cell. 

The SPRimager®II measures changes in 

the reflected light intensity across the 

whole optical field of the gold film.  This 

two-dimensional imaging is done by 

focusing the reflected light with an 

imaging quality lens onto the CCD 

detector.  Reflectivity changes that occur 

when an analyte molecule attaches to 

surface-bound probes are monitored in 

real time.  Simultaneous monitoring of the 
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entire surface helps to implement robust experimental controls that guard against perturbations that 

might be caused by slight changes in temperature or buffer refractive index.  The array format also 

enables some probe spots to be utilized as positive and negative controls. 

Because efficient video-capture software and hardware are provided as part of the SPRimager®II 

system, you both monitor and view changes in reflectivity as they occur.  The real-time view of the 

experiment is helpful for estimating how long to continue capturing data, and is also a valuable 

biochemistry teaching aid. 
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Appendix I  Components List for your SPRimager®II 
System 
The following items are included with the SPRimager®II system: 

 

 GWC SPRimager®II:  This is the main unit, GWC cat # SPR-IMG-802 

 GWC SpotReady™16 Chip:  Glass slides 18mm x 18mm with 16 gold spots per chip (GWC 

catalog #SPR-1000-016);  or 

 GWC SPRChip™:  Glass slides 18mm x 18mm with a uniform gold coating (GWC catalog 

#SPR-1000-050). 

 SPR prism:  A 60° prism made of SF10 glass, with the precise refractive index needed for 

SPRimager®II measurements (GWC cat #SPR-1000-051). 

 Cell holder with a detachable prism wedge and clamping screw (GWC catalog #SPR-1000-052). 

 Flow cell with four 8-32 x 1-inch socket head cap screws (GWC Catalog #SPR-1000-053). 

 Viton O-ring (GWC cat #SPR-1000-054). 

 Inlet and outlet ports to connect the flow cell to the fluid flow (GWC cat #SPR-1000-055). 

 Replacement lamp, GWC Cat #SPR-1000-056. 

 Plastic-tipped tweezers for handling the gold chip (GWC Cat #SPR-1000-057). 

 Index matching fluid (index of refraction =1.720;  Cargille Laboratories Series M fluid). 

 Silicon tubing for the pump.  0.031‖ internal diameter, 12‖ long (GWC Cat #SPR-1000-059). 

 Hex wrench set.  (GWC Cat #SPR-1000-058.) 

 SPRimager®II Manual.  (GWC Cat #SPR-1000-060.) 

COMPUTER COMPONENTS 

 Power Cord. 

 Video Capture Board—to facilitate transfer of image data from the SPRimager®II to the PC. 

 BNC Cable—to connect the SPRimager®II to the video capture board in the computer. 

 V++ Software kit and dongle—your image analysis software package. 

 User CD—a compact disk with software for the video capture board and macros for V++. 

 PC and Monitor—unless you elected to supply your own computer system. 

 Windows® XP Professional—unless you elected to supply your own computer system. 

 Microsoft Office® Standard—unless you elected to supply your own computer system. 
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Appendix II:  Changing the Lamp 
 

The lamp in the SPRimager®II will eventually burn out.  If you are not sure whether the lamp is 

operational, place a small white card or piece of paper between the polarizer and the prism when the 

power is switched on.  If the lamp is lit, you will see a circular disk of light on the card. 

To ensure peak performance always use lamps obtained from GWC Technologies, and follow this 

procedure carefully when changing the lamp: 

1. Turn the SPRimager®II power switch (rear panel) off and unplug the power supply cable. 

2. Remove the BNC cable (rear panel). 

3. Remove the four screws, two on each side, that secure the cover to the baseplate. 

4. Gently lift the cover, pulling gently outwards on the front panel area to ensure the cover clears the 

control knobs on the instrument. 

5. Find the screw located leftmost on top of the illumination cylinder, as viewed from the front of the 

instrument, and remove it (image below left). 

Do not loosen any other screws. 

6. Gently slide the circular lamp holder leftwards out of the illumination cylinder (image below 

right): 

Be careful not to pull hard on the electrical supply wires as you ease the holder out. 

7. Put on a pair of clean gloves 
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8. Remove the lamp from the holder by gripping the lamp firmly and pulling it away from the 

connector at its base (below left). 

9. Remove the replacement lamp from its box, then, remembering to keep wearing the gloves, 

remove if from the protective plastic pouch (below right) 

10. Insert the lamp into the fixture (above left) firmly as far as it will go. 

11. Feed the electrical connectors back into the illumination cylinder, then push the lamp holder back 

into the end of the cylinder as far as it will go.  Rotate the fixture if necessary to align the screw 

hole in the fixture with the screw hole in the flange. 

12. Keeping the fixture firmly pushed as far into the cylinder as it will go, insert the screw and tighten 

it firmly. 

13. Replace the cover and tighten the screws in the reverse order of steps 3 and 4 above. 

14. Reconnect the BNC cable and the power cable, then turn the instrument on. 
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Appendix III:  How to setup the SPRimager®II 

SETTING UP THE COMPUTER 

If your SPRimager®II system purchase included installation, the steps in this section will already be 

completed by your installation team and you can go straight to the section ―How to use your 

SPRimager®II on page 5. 

If your system purchase did not include installation, you will need to follow these steps in the 

order listed: 

1. Place the SPRimager®II on a stable, vibration-free surface away from direct sunlight and clear of 

any sources of hot or cold air or other temperature disturbances. 

2. Ensure your Windows computer has the appropriate operating system and application software. 

3. Install the XCAP software and drivers for the video board 

4. Install the supplied PIXCI video capture board in the computer you will use to control the 

SPRimager®II 

5. Install the V++ image analysis software 

6. Install and test the V++ driver software for the video capture board 

7. Install the GWC Line Profile (lprofile.exe) program 

8. Install the GWC Macro module for V++ 

 

Ensuring your Windows computer has the appropriate operating system and 

application software 

If your computer has the Windows® XP Professional operating system installed, the SPRimager®II 

and driver software will install and run normally.  The Windows® XP Home operating system is not 

supported for SPRimager®II applications;  if you have this installed on your computer, we 

recommend you upgrade to XP Professional. 

If your computer has the Windows® 2000 operating system installed, the SPRimager®II and driver 

software require that it has been updated to at least service pack 4 (SP4).  To check which version of 

Windows 2000 you have: 

9. Open Windows Explorer (on the Desktop, right-click on My Computer, then choose Explore). 

10. From the Windows Explorer Help menu, choose About Windows.  The ensuing dialog indicates 

the version, build and service pack currently installed on your computer. 

11. If the service pack installed is at least service pack 4, there is no need to upgrade the operating 

system, and you can proceed to installation of the XCAP software (next section). If you do not 

have at least Windows 2000 service pack 4 installed, you will need to upgrade as outlined in step 

12. 

12. To upgrade your Windows 2000 operating system, open your browser application, go to the 

Microsoft.com web site, navigate to the Windows product section, locate the downloads section, 

then select the Windows 2000 service pack 4 (or higher) download.  Follow the on-screen 

instructions to upgrade your computer. 
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Install the XCAP Software 

The XCAP software is required for your computer to recognize and communicate with the video 

capture board.  For the rest of the system to work correctly, you will need to have XCAP version 2.2. 

or higher. 

If the computer you are using has had XCAP installed previously, uninstall the prior version of 

XCAP before you install the new version.  Briefly, to install XCAP: 

1. Insert the Epix CD into the CD drive of the computer you will use to control the SPRimager®II.  

This will launch the installer.  If the installer does not launch, use Windows Explorer to locate the 

setup.exe file on the CD and double-click on it to start the installation procedure. 

2. When the installation wizard launches, accept the licensing terms, choose to setup the PIXCI® 

imaging software, and select XCAP: 

3. Click OK then accept the default options suggested in the subsequent screens.  When you are 

asked if you want to start the XCAP program, choose No. 

Install the PIXCI video capture board 

The PIXCI video capture board is required so your computer can capture the data from the 

SPRimager®II efficiently. 

Briefly, to install this hardware: 

1. Shut down the computer and disconnect the power cord. 

2. Open the computer case and insert the capture board into an open PCI slot in the computer. 

3. Close the computer case, reconnect all connectors and start the computer. 

Once Windows® is started, you should see a message that new hardware has been found, and 

the Hardware Wizard will launch. 

4. When the ―Found New Hardware Wizard‖ launches, a dialog box will appear asking ―Can 

Windows connect to Windows update to search for software?  Click the radio button for ―No, not 

this time‖, then click Next. 

5. In the next dialog, click the radio button for ―Install from a list or specific location‖, then click 

Next. 


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6. In the next dialog, click the radio button for ―Search for the best driver in these locations‖, then 

click the checkbox for ―Include this location in the search‖.  Then Browse to the location 

C:\XCAP\drivers\WinXP and click Next. 
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7. Accept the licensing terms and choose the default options suggested.  Ignore any warnings you 

receive indicating that the software is not digitally signed or that the software has not passed 

Windows® testing, and continue with the installation. 

8. When you complete steps 4-7 the first time, you will be prompted once more with the Found New 

Hardware Wizard.  Repeat steps 4-7 a second time before proceeding to step 9. 

Although you installed only one item of physical hardware, the video system includes two 

virtual hardware items, the video capture controller and an audio controller.  The second 

round of installing new hardware installs the audio controller.  Although you will not need this 

for SPR imaging work, you should install the audio controller so that you do not receive error 

messages when starting Windows. 

9. At the end of the second installation procedure, be sure to click the Finish button. 

You may now receive notificaiton that the new device is not configured correctly.  The restart 

procedure will complete the configuration routine. 

10. Restart the computer when prompted. 

11. Launch the XCAP program from the Start menu.  When prompted to enter a code number to 

activate the software, refer to the XCAP CD envelope to locate this code in the format 

XXXX/XXXX/XXXX where X is an alphanumeric character.  Type this code (including the ―/‖ 

characters) into the type-in box then click OK. 

12. When prompted to restart XCAP, click YES. 

This restart is necessary to activate the license. 

This restart is required so that the capture board will be configured correctly. 

13. To confirm that the capture board is now configured correctly and working, open the Device 

Manager (from the Control Panel, choose System, click on the Hardware tab, then click Device 

Manager).  Click on the plus sign by the Imaging devices listing and view the device name.  The 

video driver should be listed there as PIXCI(R) SVC PCI Video Capture Board for 

Win 2000/XP.  When you right-click on this name and choose Properties, the pop-up window 

will indicate This Device Is Working Properly. 
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Install the Digital Optics V++ image analysis software 

Instructions for installation are included in the V++ package that accompanies your SPRimager®II 

system.  For the rest of the system to work correctly, you will need to have V++ version 4.0 or higher.  

Briefly, to install this software: 

1. Insert the V++ CD into the CD drive of the computer for the SPRimager®II to launch the 

installation wizard.  If the installer does not launch, use Windows Explorer to locate the 

setup.exe file on the CD and double-click on it to start installation.  Click the Install button. 

2. Accept the licensing terms and choose the default installation options for V++, including Full 

Installation. 

GWC provides additional macro functions (installed later) for V++.  In order for the 

installation and usage to work properly, it is essential that you install the V++ program in the 

default location. 

3. When presented as an option, select 

Additional Tasks and check the box for 

Enable video camera support.  Also 

check the appropriate boxes if you want 

to add icons for launching: 

Click the Next button, then on the next 

screen select Install. 

4. Before clicking the Finish button, ensure 

the radio button for ―Install/update the 

security key system driver‖ is checked. 

5. Click Finish.  This will complete the 

V++ installation and then launch the 

installer for the security system that 

limits access to V++ to licensed users.  

Accept the default settings offered to complete the installation of the Sentinel security system for 

V++. 

At this point you may be prompted to restart the V++ program to complete the activation 

process.  However, you do not need to restart the computer. 

6. Attach the V++ dongle (included in the V++ package) to your computer’s USB port. 

The V++ dongle is a security device that is required to run V++.  If the dongle is not installed, 

V++ will not run.  This security system can be very convenient because it allows you to install 

V++ on multiple computers, but lets you run on only one computer at a time. 

7. Restart V++. 

Install and test the V++ driver software for the video capture board 

Although the V++ program is now installed, it may not yet recognize the video capture board.  

Next you need to install a V++ driver that enables the program to recognize and communicate 

with this board. 

A V++ driver file for the capture board is included on the V++ CD.  If you want to check for a 

more recent driver, you may browse for one on the Digital Optics web site at 

www.digitaloptics.co.nz/download/videodrivers.htm.  Look for the driver for the PIXCISV5 

video board.  The setup file  will have a name similar to SetupPIXCIDriver15.exe.  To 

install, download this file to your desktop then go to step 3 below.  If you are using the driver 

supplied on the V++ CD, start at step 1. 
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1. Insert the V++ CD into the CD drive of the SPRimager®II computer. 

2. Use Windows Explorer to navigate to the \Video Drivers\Installers\ folder on the V++ 

CD. 

3. Double-click on the file SetupPIXCIDriver15.exe to launch the installer for the PIXCI 

driver. 

4. Follow the on-screen instructions, accepting the license terms and default options.  Click Finish to 

complete the installation. 

Although installation is now complete, you should check that the computer can communicate 

with the camera in the SPRimager®II.  To do so: 

5. Connect one end of the BNC cable to the SPRimager®II, and the other cable end to the BNC1 

connection on the video capture board connector in the back of the computer. 

Note that your capture board has two round BNC connectors.  Be sure to choose BNC1, which 

is the one nearer to the screw that holds the board in the computer. 

6. Turn on the power switch for the SPRimager®II. 

7. On the computer, launch V++. 

8. From the V++ Tools menu, choose Options. 

9. From the options menu, choose the Add-ins tab, select the options shown in the picture below left, 

then click OK. 

10. From the V++ Video menu, choose Configure.  Select the options shown in the picture above right, 

then click OK. 

Now you are ready to test the communication between the SPRimager®II and the camera. 

11. From the V++ Video menu, choose Focus.  This launches the focus window. 

12. In the Focus window, click the Focus button (top left button in this window). 

At this point, the focus window will appear black.  Now you want to confirm that the window 

turns white when light enters the camera. 

13. Lift the lid off the SPRimager®II and shine a flashlight directly into the camera lens.  The Focus 

window will turn white when the physical connections and software drivers are correctly installed. 

14. Close the V++ program. 
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Install the GWC Macro module for V++ 

V++ includes several macro functions that expand its capabilities.  These macros are located 

in “module “ files in the \Modules\ folder inside the \V++\ folder.  Modules comprise 

one or more macros that can be compiled and run when V++ is launched.  If you want to 

create or modify any modules, you may do so in the Module editor in V++.  Be sure to create a 

copy of the module you want to edit before you make changes so that you always have the 

option to revert to the original unedited module. 

GWC provides nine additional macros for V++, in a module called GWCmodule.v.  These 

macros make it easier for you to use the SPRimager®II to collect data.  To install these 

macros correctly, you will need to use the installation routine we provide, because one of the 

macros requires the GWC program Line Profile to be installed as well.  The installation 

provided installs this program as well as the macros. 

1. Close any programs that are running on your computer. 

2. If you already have GWC macros installed, you should remove them.  If you don’t have GWC 

Macros installed, please go to the next step.  To remove the macros:  From the V++ Modules 

menu, choose Module List.  Select the GWC macro item from the list (it will have the word 

―module‖ in the name) then click the Startup button.  Click the radio button for the first option, 

―Do not automatically load this module at startup‖, then click OK, then Close.  Close V++. 

If you have modified any of the macros in the earlier version of the GWC Module, rename the 

Module file if you haven’t already, then open the file in V++, and perform steps 6-9 below for 

the renamed module as well as for the new module. 

3. Use Windows® Explorer to locate the file Setup.exe in the \GWCmodule\ folder on the GWC 

CD.  Double-click on this file to launch the installation routine, and follow the on-screen 

instructions to install the macros.  Accept all of the default options. 

This installs the GWC module in the \V++\Modules\ folder, and also installs the GWC 

Line Profile program in the Windows systems folder. 

4. Launch V++ from the Start Menu shortcut or from the desktop shortcut if you made one. 

5. From the V++ File menu, choose Open, then navigate to the folder C:\Program 

Files\Digital Optics\V++\Modules\.  Locate the.GWCmodule.v  file in this folder 

and choose Open.  A screen like the following one appears: 

GWCmodule.vGWCmodule.v
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The GWCmodule.v file is a V-Pascal script containing several macro functions.  The file is 

source code, and opens in V++ in a text editing window.  You should not edit this file—if you 

want to modify the macros, first create a copy of this file and edit the copy. 

6. Right-click with the mouse in the GWCmodule.v text window, and in the pop-up menu select 

Compile.  Nine new buttons (circled in the picture below) should appear in your button bar.  The 

location of the new buttons depends on the size of the V++ window, on your screen resolution, 

and on which current button menus are turned on: 

This procedure serves as a check to make sure that the module compiles.  However, you will 

want the GWCModule.v file to load and compile every time you open V++. 

7. To ensure the GWCModule functions are available each time you start V++, choose Tools > 

Module List.  This launches the following dialog: 

If you forgot to compile the macro, its status will be “Not compiled” instead of “Ready to run”. 

8. Highlight the GWCmodule.v name to activate the buttons at right, then click the Startup button to 

launch the following dialog: 

9. Click the radio button for Load and compile this module at startup, then click OK. 

This choice ensures that the extra  functions provided by GWC will be loaded into V++ and 

ready to use every time V++ is launched in future. 

Each of these buttons adds a function to V++ that you may find useful.  The functions of the 

buttons are described in the next section. 

Troubleshooting tip: On rare occasions the GWCModules toolbar will not appear on starting 

V++ (typically after a software crash). In this case repeat steps 6-9 above. 

10. Close the GWCmodule.v window and close the V++ program. 



 


